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ABSTRACT 

 

   The purpose of this work is to reduce the operative 

time and blood loss incurred during open reduction and 

internal fixation (ORIF) of traumatic pelvic injuries 

through the creation of patient specific bending templates 

for reconstruction plates. These templates are 3D printed 

in a resin capable of being sterilized and taken into the 

operating room so that bending may be performed by the 

surgeon before the patient is opened or by another team 

member in parallel with the surgeon.  

   A novel software extension was created in 3D 

modeling software to allow a surgeon to individually 

position screws on a pelvic model to create a virtual 

plate. The software constrains the locations of placed 

screws so that the virtual plate is dimensionally identical 

to common reconstruction plates. The user is then able to 

export a bending template that includes the section of the 

pelvis the virtual plate was located on as well as screw 

location landmarks. The user can then flash sterilize the 

template and use it intraoperatively to obtain a plate that 

is accurately bent to the patient’s anatomy and the 

surgeon’s specifications.  
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   We produced a bending template representative of 

the most complex plating location on the pelvis, the 

posterior wall. A surgeon then accurately bent 

reconstruction plate to match the bending template, proving 

that the software produced a dimensionally accurate output. 

Other work has shown that the pre-bending of plates can 

shorten operative time, reduce blood loss, and allow for 

less invasive procedures. However, methods currently 

available for pre-bending patient specific plates involve 

the lengthy process of printing the patient’s pelvis and 

then a lengthy sterilization process of the implant itself. 

Our method allows the template to be printed and processed 

in as little as 3 hours and sterilized by autoclave in less 

than 10 minutes.  

Further work needs to be done to evaluate how the 

process works when used in a patient case, to statistically 

prove that our method reduces operative time and blood 

loss, and show that plates bent using our method are 

similar between all members of the surgical team. 
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I. INTRODUCTION 

 

A. Background 

 

        Treatment of any orthopedic injury begins with 

initial evaluation of the injury. Plain film X-rays are 

used as the initial evaluation in almost every injury but 

computed tomography (CT) scans provide a more accurate 

diagnosis [1]–[3] and are often used in more serious 

injuries. Many orthopedic injuries are not polytrauma but 

the most traumatic injuries can result in excessive 

internal bleeding, neurological damage, urogenital issues 

or other injuries that must first be dealt with before the 

orthopedic injury can be treated [4]–[6]. After the patient 

is medically stable, they can receive definitive treatment 

of their orthopedic injuries. Orthopedic treatment consists 

of reduction and fixation of the fractured bone fragments. 

Reduction is the process of moving the fractured pieces of 

bone back into their original anatomic locations and can be 

performed using non-surgical or surgical methods. The non-

surgical methods are called closed reductions and are 

preferred for minor injuries. Surgical, or open, reduction 

is performed in an operating room with the patient under 
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anesthesia and is necessary when a complicated fractured 

has been sustained. Fixation is the process of ensuring 

that the bone fragments do not move from their reduced 

positions while the bones heal and is generally classified 

as either conservative, external, or internal. An example 

of conservative fixation is a plaster cast or a brace and 

is usually used to treat simple fractures. External 

fixation is a metal construct that consists of pins 

inserted through the skin and secured in bone and bars and 

clamps that reside outside of the patient’s body to hold 

the pins in the proper location and orientation [7]. 

Patients with severe injuries will often need their 

fracture initially stabilized but will not be able to 

receive a definitive treatment until more serious injuries 

are resolved. External fixation allows for temporary 

fixation of a fracture while still allowing access to the 

surrounding soft tissue. Internal fixation is the current 

standard of care for many orthopedic injuries as it allows 

for quicker treatment and rehabilitation of the patient. 

Internal fixation is performed using K-wire, a thin smooth 

metal pin, screws, and reconstruction plates to hold 

fracture fragments in place.  

   Orthopedic injuries to the pelvis are often caused 

by high energy events such as motor vehicle accidents, 
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being struck by a vehicle, or falling [5]. Pelvic fractures 

are often polytrauma and most patients receive both plain 

film X-rays and CT scans upon their arrival to the 

emergency department (ED). The definitive treatment for 

many pelvic injuries is open reduction and internal 

fixation (ORIF). While some injuries can be treated using 

only screws, the use of reconstruction plates is common and 

recommended for many pelvic ORIF procedures either because 

it is the only way to properly secure the fragments or 

because it offers increased stability and strength to the 

pelvis while it heals [8]. Reconstruction plates are made 

of either titanium or steel and generally consist of a 

straight piece of metal with holes that allow it to be 

secured to the bone using screws. Some plates, called 

locking plates, have threads manufactured into holes the 

screws pass through and allow the screws to lock into the 

bone and the plate in place. Non-locking plates rely solely 

on compression to keep the plate in the proper location. 

 

 
Figure 1 - A Six-Hole Reconstruction Plate. 
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   In many ORIF procedures, such as long bone repair, 

these reconstruction plates do not require any further 

modification to properly hold the fragments in place. The 

pelvis however, has a unique anatomy and often requires 

that plates be bent to maintain the correct position of the 

bone fragments. Common pelvic locations for reconstruction 

plates include the pubic symphysis, iliac wing, anterior 

brim, and acetabulum [4], [9]–[12].  

 

 
Figure 2 - Common Pelvis Plate Locations. Left image is a 

Posterior Wall Plate and the right image is an Anterior 

Brim Plate [13]. 

  

Some orthopedic sets have used anatomic data from 

large populations to create pre-bent plates for locations 

like the anterior brim and posterior column[13]–[16].  
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Figure 3 - Acumed Pre-Bent Plates. The left-hand image is of 

Acumed Posterior Wall plates and the right-hand image is 

of Acumed intrapelvic, anterior brim, and pubic symphysis 

plates [13]. 

    

However, the patient anatomy and fracture pattern is 

different for every case and these plates will often 

require further bending to properly contour to the pelvis 

and provide the necessary fixation.  Additionally, it has 

been shown that since these pre-bent plates are often 

designed using dimensions of a single demographic, the fit 

of the plate and subsequent quality of the fixation varies 

across patient populations[17]. To assist in the bending 

process, some orthopedic sets contain additional malleable 

aluminum plates. This allows the surgeon to contour the 

aluminum plate to the reduced fragments and then bend the 

titanium reconstruction plate to match their aluminum 
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plate. Regardless of the type of plate used in the surgery, 

all reconstruction plates will still require further fine 

tuning to match the exact anatomy of the patient that can 

only be achieved after the patient has been surgically 

opened and the fracture has been fully reduced. This 

requires the surgeon to expose the fracture site and open 

several other windows in the patient to assist with 

visibility and reduction during the surgery [18].   

   The plate bending process is not well described in 

orthopedic textbooks or literature and this knowledge is 

most often gained by surgeons through observation or 

practice within the operating room (Correspondence with 

Brandi Hartley M.D., 2017). In ‘Fractures of the Pelvis and 

Acetabulum’ Tile, Helfet, and Kellam [6] state that 

posterior column fractures can be fixed  

“with a well-contoured plate that crosses the main 

fracture line of the posterior column.” (p.636) 

 

Similarly, when treating an anterior wall fracture, 

“it is more effective to pre-contour a pelvic 

reconstruction plate and slide it under the 

vessels...centered along the pelvic brim” (p.639)  

 

and when repairing a fracture of the anterior column 

 

“definitive fixation is provided by the application of 

a pelvic reconstruction plate. The plate must be accurately 

contoured to the pelvic brim.” (p.640) 
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   Gardner and Henley expanded upon descriptions of 

contouring methods in their book, ‘Fracture Surgery’[18]. 

The authors provide the following instruction to aid in 

contouring a pubic symphysis plate,  

“Place a slight pre-bend in the center and again just 

medial to both peripheral holes” (p.129).  

 

When describing posterior column repair, Gardner and Henley 

simply state that an,  

“under-contoured 3.5 reconstruction plate is usually 

sufficient for the application” (p.152), 

 

and while describing the contouring of an intrapelvic plate 

they state,  

“It should have a slight under contoured bend to 

accommodate the quadrilateral surface and should be 

twisted...to allow easier screw insertion into the superior 

ramus.”(p.163)  

 

   ‘Surgical Treatment of Orthopedic Trauma’ by 

Stannard, Schmidt, and Kregor provides the most detail on 

how specific reconstruction plates should be contoured 

[19]. When describing how to contour pubic symphysis plates 

the authors state,  

“The surgeon bends the superior plate down ~15 degrees 

before the last hole on each side of the plate where the 

pubis bone connects with the rami.” (p.453) 

 

For plates placed on the posterior wall, the authors do not 

describe how to correctly bend the plate but instead point 

out the following three common errors in plate bending:  
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“Over-contouring of the plate so that the superior and 

inferior aspects of the plate contact the bone, but the 

plate over the midsubstance is not sufficiently buttressing 

the posterior wall” (p.490), 

 

“not bringing the plate peripheral enough on the 

acetabulum so the posterior wall is not adequately 

buttressed” (p.490) 

 

and, 

 

“not bending the plate ‘on the flat’ so that the plate 

instead goes straight up the posterior column rather than 

curving more anteriorly above the acetabulum.” (p.490) 

 

   The authors do not describe any contouring for 

anterior brim plates but it is known that additional 

contouring of pre-bent reconstruction plates is often 

necessary to bend them around the pubic ramus 

(Correspondence with Brandi Hartley M.D., 2017), [18] 

 

 
Figure 4 - Improperly and Properly Contoured Pelvic Wall 

Reconstruction Plates. [19] The top figures show improperly bent 

posterior wall plates. The bottom left image shows the 

appropriate contouring of the plate. 
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   We can see that the use of contoured plates is 

heavily described in orthopedic textbooks but descriptions 

of the methods needed to achieve these accurately contoured 

plates are rarely included. Most often, plate bending 

knowledge and techniques are passed along in the operating 

room during training making the quality of and the time 

needed to bend a reconstruction plate a function of the 

surgeon’s experience. This potentially leaves a gap in the 

knowledge of surgeons who either do not see a high volume 

of orthopedic trauma or who are still in training. It also 

prevents other surgical team members such as technicians, 

nurses, or residents, from taking over what should be a 

relatively simple task. 

   The quality of the reduction of a pelvic fracture 

is a key determinant in how well the injury will heal which 

makes the accuracy of the reconstruction plate essential to 

the patient having a good recovery. Not achieving a proper 

reduction or not providing an adequate fixation to hold the 

reduction will result in a variety of complications such as 

osteoarthritis as well as osteoarthritis, gait problems, 

limb length discrepancies, urinary tract problems, and pain 

[6],[20].   
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   The goal of all ORIF procedures is to provide 

functionality back to the patient as quickly as possible 

and can be accomplished through proper reduction and 

fixation. However, greater blood loss during a procedure 

correlates to poor clinical outcomes and increased time in 

the operating room increases the risk to the patient and 

the cost of the procedure. This makes evident the need for 

a solution that can provide high quality fixation, reduce 

operative time and blood loss, and make the plate bending 

process more accessible to less experienced surgeons and 

other surgical team members.  

B. Review of 3D Printing for Plate Bending and Virtual 

Planning in Orthopedic Surgery 

 

        Methods for bending orthopedic plates to conform to 

a specific patient’s anatomy have been described for the 

jaw and the pelvis. Some of these methods simply expand 

upon the idea of using a saw bone for surgical 

visualization and some methods advocate for or demonstrate 

the 3D printing a completely patient specific 

reconstruction plate. The most advanced and practical 

methods currently available combine a virtual planning 

environment that allow the surgeon to plan the exact 
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location of plates and screws and provide a physical output 

to assist the surgeon with the procedure. 

        3D printing as a method of surgical planning is 

becoming more common place in orthopedic surgery and is 

being used to print patient models [21]. This approach was 

used in a 2015 study to view the relative displacement of 

fragments before surgery [22]. Another study used similar 

methods, but the authors autoclaved their patient specific 

pelvic models to assist with bending their plates and 

visualizing fracture fragments while in the operating room. 

In a 2002 study, the authors used a printed model of their 

patients pelvis to contour a reconstruction plate and 

create a screw guide [23]. In a 2014 study, patient 

specific pelvic models were used to determine proper 

reconstruction plate size and screw lengths [24]. These 

models were also sterilized and taken into the operating 

room to give the surgeon the ability to examine the printed 

pelvis and fracture pattern as they repaired it or contour 

the plate to the surface of the pelvic model before 

implanting it in the patient. 3D Printed models are also 

common in oral and maxi-facial reconstruction. Multiple 

studies have created virtual, bent plates and compared 

their accuracy to that of a hand bent plate [25], [26]. 

Other studies used virtual methods to model the repair of a 
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mandible and then printed the model to assist in the 

bending of their plate [27],[28].  

   Beyond the simpler methods described above, some 

authors have used the rise in rapid prototyping technology 

to create completely patient specific reconstruction plates 

and 3D print them in titanium using selective laser melting 

(SLM) or Electron Beam Melting (EBM)[29]. In addition to 

improved patient fit, researchers have shown increased 

strength [30],[31] and improved biocompatibility [32] are 

also possible with additive manufactured titanium implants. 

Despite these benefits, large regulatory barriers exist 

that make customized reconstruction plates rare and 

impractical in the United States. 

   Surgical planning software can combine patient 

specific details and avoid many of the regulatory hurdles 

that advanced additive manufacturing technologies face. A 

surgical planning system described in 2012 used data of the 

patient’s intact anatomy as a base that the surgeon could 

draw their desire reconstruction plate onto [33]. They then 

used virtual reality (VR) equipment to project the virtual 

plate on-screen to guide the surgeon in bending an aluminum 

plate. The contoured aluminum plate was then sterilized, 

taken into the operating room, and used as a template to 

bend the titanium reconstruction plate. In 2007, Cimerman 
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and Kristan created a software tool to assist in surgical 

planning [34]. Within the software, the user could segment 

and separate out all bone fragments as individual pieces, 

reduce the fractures, and add plates and screws to simulate 

fixation. Most recently in 2017, Chen used CT scan data and 

MIMICS to create screw guides and bending templates [35]. 

They then 3D printed their guide and template and 

demonstrated their use on cadaver pelvises. Using the screw 

guide, the authors first placed k-wire pins. They then 

removed the guide, bent a plate using their template, and 

placed the plate onto the pelvis. Finally, they removed the 

pins and replaced them with screws to hold the plate in 

place. 

C. Purpose 

 

        This thesis will describe a method that allows the 

surgeon full flexibility within a novel software extension 

to precisely position a virtual plate to create an accurate 

bending template for a reconstruction plate. This anatomic 

bending template is 3D printed in a material that allows it 

to be sterilized and brought into the operating room. This 

removes the time delays associated with other methods that 

involve printing an entire hemipelvis or re-sterilizing the 
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orthopedic implant. Finally, this method delivers a pre-

bent reconstruction plate that produces identical, if not 

better, results than that which could be achieved through 

contouring the reconstruction plate on a saw bone or a 3D 

printed model of a patient’s pelvis through the addition of 

screw landmarks on the template being printed. These 

landmarks provide tactile and visual confirmation to the 

user that the plate has been properly bent and allows for 

other members of the surgical team, such as technicians, 

nurses, or residents, to produce the same results as the 

surgeon that designed the plate. Other authors have 

proposed anatomically contoured and pre-bent plates as 

allowing the fixation of fractures to be done using less 

invasive methods than the traditional approaches [33], 

[36]. The current standard of care involves direct exposure 

of the fracture site to allow the surgeon to bend the plate 

to match the patient’s anatomy and fracture pattern. Using 

our proposed method, the plate could be fully contoured 

before the patient is opened which will reduce the time 

needed for surgery, the blood lost by the patient, and 

could reduce the size of incision needed as well as remove 

the need for direct exposure of the fracture site. Overall, 

this system will allow for shorter operative times and 

reduced blood loss by the patient with the potential to 
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allow for a less invasive surgery with better clinical 

outcomes.  
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II. INSTRUMENTATION AND EQUIPMENT 

 

 

A. Software 

 

        The following six software packages are used to 

create a physical bending template from DICOM CT images: 

Solidworks (Solidworks 2016, Solidworks Corp., Waltham, MA, 

2016), ImageJ [37], MATLAB (MATLAB 9.2, The MathWorks Inc., 

Natick, MA, 2017), Slicer 4.7.0 [38], Blender (Blender 

2.78, Blender Foundation, Blender Institute, Amsterdam), 

Autodesk Meshmixer (Meshmixer 3.2.37, Autodesk Inc., San 

Rafael, CA, 2017), and Preform (Preform 2.11.3, Formlabs 

Inc., Somerville, MA, 2016). Additionally, CloudCompare 

(CloudCompare 2.9, 2017) was used for STL file comparison. 

ImageJ is used to import DICOM files, process them, and 

export them as an image stack in a TIFF format. TIFF is a 

useful file format for working with medical imaging data 

because it allows all slices, or individual images, of the 

data set to be included in a single file and makes handling 

the images much simpler. Image processing in ImageJ 
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includes threshold segmentation, hole filling, erosion and 

dilation as necessary to remove small fragments, and manual 

separation of the intact hemipelvis from the sacrum and 

other structures. MATLAB is used to calculate the amount of 

independently connected objects in a 3D image stack and 

separately save them. Slicer is used to rebuild 3D image 

stacks, smooth them, and export them as stereolithography 

(STL) files. STL files are 3D objects that have had their 

surfaces rebuilt using triangles and are the most common 

file format used in additive manufacturing. The STL 

reconstruction is then imported into Blender where a novel 

software extension has been designed to allow the virtual 

placement of a reconstruction plate. Inputs obtained during 

the virtual plate building process are then used to create 

a bending template that can be 3D printed. After the 

creation of the virtual bending template, the template is 

exported from Blender as an STL file and final processing 

is done within Meshmixer. Meshmixer allows for editing and 

preparation of STL files before they are 3D printed. Within 

Meshmixer, the virtual template model can be finalized and 

checked for errors to ensure it will print successfully. 

After final processing of the bending template within 

Meshmixer, the file is imported into Preform. Preform is 

the proprietary software utilized with Formlabs printers to 
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prepare an object for printing. Preform is used to 

customize the settings that the 3D printer will use such as 

resolution, object orientation, and support structures.   

B. Formlabs Printer and Post-Processing Equipment 

 

 
Figure 5 - Formlabs Form 2 Printer. 

 

A Formlabs, Form 2 printer was used for all templates 

printed for this work. The fundamental components of the 
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Form 2 are the UV shield, the build platform, the resin 

tray, and the resin cartridge. The build platform is where 

the part is attached and can be removed from the printer. 

The resin tray contains a reservoir of resin that is used 

during manufacturing and is refilled from material in the 

resin cartridge. The printer can only manufacture in a 

single material per print but the cartridge can be switched 

to allow for different materials to be used for different 

prints. The Form 2 utilizes SLA printing technology to 

create solid objects in a layer by layer fashion. In this 

method, the build platform is lowered into the tank of 

resin and a UV laser cures the material that is needed to 

create that layer of the part. After each layer is 

complete, the platform raises slightly and the next layer 

is created. The Form 2 is capable of build parts with 

layers as small as 25μm and has a beam resolution of 140μm 

[39].  

 

 

Figure 6 - SLA Manufacturing Process. This image compares and 

contrasts the manufacturing techniques of SLA and DLP, both of 

which involve light cured polymers [40]. 
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The resin used in the Form 2 printer is made up of a 

(meth)acrylated monomers, (meth)acrylated oligomers, and 

photo initiators. This polymer solution remains a liquid 

until it is exposed to UV light which is why the UV shield 

must always be in place unless the parts are being removed. 

The use of the laser in the building process provides a 

majority of the energy needed to solidify the resin but 

final post-processing must be performed to create the 

highest quality part.  

For post processing, a bath containing 90% isopropyl 

alcohol (IPA) and UV curing station are necessary.  

 

 
Figure 7 - IPA Bath. 



 

21 
 

 

 
Figure 8 - UV Curing Station. 

 

 

After being removed from the print platform, the user 

should immediately place the part into a bath containing 

fresh, 90% isopropyl alcohol (IPA) and allow it to sit for 

10-20 minutes. This process removes any residual, uncured 

resin that might remain on the part. After the IPA wash, 

the part should be transferred to a UV curing station with 

108 Watt, 315-400 nm and 400-550 nm wavelength bulbs and 

allowed to cure for 10 minutes. Placing the part in the UV 

curing station ensures that all photopolymers making up the 

part have been fully cured and solidified.  
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III. METHODS 

 

A. Development of MATLAB Code: 

 

        MATLAB, or Matrix Laboratory, is a programming 

language and compiler that specializes in matrix operations 

and is commonly used for image processing tasks such as 

thresholding, segmentation, and other morphological 

processing. For this thesis, two additional MATLAB packages 

were utilized: The Image Processing Toolbox and the 

Parallel Processing Toolbox. The Image Processing Toolbox 

provides additional functions that are specifically 

tailored for editing medical images and image stacks. The 

parallel processing toolbox allows MATLAB to take advantage 

of multi-core central processing units (CPU) when 

performing computationally heavy tasks. Thresholding the 

original CT image within ImageJ will result in a binary 

image that only contains pixels labeled 0, completely 

black, or 255, completely white. The white pixels represent 

a unit of bone within two dimensions. In a three-

dimensional image stack, such as a CT scan, the units of 
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bone are known as voxels and contain a height dimension in 

addition to length and width. To rebuild the intact pelvis 

from an image stack, the white voxels that make up the 

intact hemipelvis must be separated from the white voxels 

that represent other structures such as the sacrum, bone 

fragments, and miscellaneous noise. MATLAB includes a 

function, “bwconncomp”, that detects connected pixels in a 

binary image or connected voxels in a stack of images. 

After initial thresholding and manual separation of bones 

within ImageJ, MATLAB is used to isolate the intact pelvis 

for further reconstruction. 

 Before the software is run, the user has the 

opportunity to enable and change the properties on several 

image modification parameters as well as set the level of 

connectivity to be used, the size threshold, and specify if 

they want the fragments saved. After being started, the 

MATLAB code begins by allowing the user to select the TIFF 

image stack that they wish to open. The function then 

performs an initial calculation to determine the number of 

fragments, or connected collections of voxels, that are 

present in the image. A fragment is defined by the software 

as voxels that are touching based a certain connectivity 

both within the image itself and within the images above 

and below the image in question. The connectivity is 
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controlled by the user and can be changed before the 

software is run. The lowest level of three-dimensional 

connectivity is 6 where only directly adjacent voxels are 

considered connected and the highest is 26 where only the 

corners of two voxels need to be touching for them to be 

considered connected. The initial fragment check reports 

two values, the total number of connected items and the 

total number of connected items above a certain size 

threshold. The size threshold is set by the user and useful 

for eliminating noise and very small fragments that are not 

of interest from the fragment total. Next, if any image 

editing processes were enabled by the user before the 

program was started, these are executed. The editing done 

to the image stack in ImageJ is only an approximation so 

this further image processing is useful to see how 

something like an erosion changes the number of fragments 

in the image. Often, an erosion in MATLAB is needed to 

fully disconnect the intact hemipelvis and sacrum. After 

image processing, the software recounts the number of 

connected voxel groups based on the processed stack of 

images and provides a new value of the total number of 

fragments and the number of fragments above the size 

threshold. If the user elected to save the fragments before 

starting, the program will save each fragment as its own 
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TIFF stack. The number of fragments saved will be equal to 

the number of fragments greater than the size threshold. 

The user can then open the fragment stacks to determine 

which file contains the bone of interest.  

B. Development of Blender Extension: 

 

   1. Introduction and Loading Extensions.  Blender is 

a 3D modeling program that is commonly used in the 

development of assets for animations and games. The value 

of Blender in this thesis is that it allows for STL files 

to be imported and any model built within the software can 

be exported as an STL file. Additionally, Blender allows 

the user to develop extensions to the software by writing 

them in the programming language, Python (.py). For this 

thesis, a software extension was written that allows for 

the creation of customized bending templates.  

 Extensions in Blender can be installed by selecting 

“File” -> “User Preferences...”, selecting the top tab 

labeled ‘Add-ons’ and selecting the ‘Install New Add-

ons...’ button at the bottom of the panel. The user can 

then navigate to the location of the add-on saved as a 

‘.py’ file. The add-on should then be present in the Add-

ons list. The user can now select the box at the left of 
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the addon’s name to enable it and afterwards should restart 

the software. 

 

    2. ‘Load Template Pelvis’.  To begin, the user must 

import the STL file of the pelvis they want to use to 

design the plate. For the development of the extension, a 

female hemipelvis from the online 3D database Thingiverse 

was used [41]. If the user presses the ‘Load Template 

Pelvis’ button, a high quality, right hemipelvis will be 

imported into the software. After the pelvis is imported 

but before control is given back the user, the software 

will center the pelvic model back middle of the screen, 

properly rename the model, and apply the necessary 

transforms so that plate building can occur. 
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Figure 9 - Blender Extension Side Panel and Pelvis Model. This 

image points out the location of the side panel as well as 

identifying key items located in the Blender window. 

 

 

    3. ‘Place 6 Hole Plate’.  This button will 

important a STL model of a six-hole plate that is 

dimensionally similar to those currently on the market. 

This function is not used in current methods of plate 

bending and its function is discussed during the 

discussion. 

    

   4. ‘Place Screw Hole’.  This button is the backbone 

of the virtual plate creation software. After a pelvis is 
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loaded and oriented, the user can left-click on the pelvis 

where the first screw will be located. The 3D cursor moves 

to that location and pressing the ‘Place Screw Hole’ button 

on the side panel places the first screw.  

   When the 3D cursor is first placed onto the pelvis, 

the software selects the nearest triangle making up the 

surface of pelvic model. The software then expands the 

selection of triangles outward several times to cover a 

similar area to that of overlying virtual plate. The 

central point and the average normal vector to the 

selection of triangles are calculated. An STL model 

representing the screw hole was created in Solidworks. It 

is 3mm thick, has an outer diameter of 10mm and an inner 

diameter of 4.5mm to mimic the dimensions of many Stryker 

reconstruction plates. When the screw hole is placed, this 

STL file is imported into the software, placed at the 

calculated center point, and rotated based on the average 

normal of the triangles below it. ‘Shrinkwrap’ is a 

constraint available within Blender to constraint one 

object to the surface of a target and a setting is 

available to offset the object a certain distance from the 

target’s surface. The software then applies a ‘shrinkwrap’ 

constraint to the imported screw hole with an offset of 

1.5mm. Since the total thickness of the imported screw hole 
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model is 3mm, this constraint places the virtual plate 

exactly on the surface of the pelvis. After the screw hole 

is imported but before the software gives control back to 

the user, a 3.75mm sphere is imported and a circle is 

created at the same central location of the screw hole. The 

sphere has the ‘shrinkwrap’ constraint applied with no 

offset distance and is a landmark showing where a screw 

would be placed on the real pelvis. The circle undergoes 

the same rotations as the screw hole and represents the 

distance at which the user should place their next screw 

hole. Since this virtual plate is intended to mimic a 

physical reconstruction plate that must eventually be bent, 

the software has several constraints to ensure the 

dimensions of the virtual plate will mimic the dimensions 

of the real plate as closely as possible. This circle is 

created with a user defined radius that corresponds to the 

distance between holes on the physical reconstruction 

plate. The default setting is for a plate with a distance 

of 13mm between screw holes, making the radius of the 

circle 13mm.  

 

Total Plate Length (mm) 

Number of Screw Holes
= 𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝐵𝑒𝑡𝑤𝑒𝑒𝑛 𝑆𝑐𝑟𝑒𝑤 𝐻𝑜𝑙𝑒𝑠          (1) 
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The intention is for the user to place the next screw 

on the perimeter of this circle to avoid improper 

orientation or dimensioning of subsequent screw holes.  

The second screw hole is placed similarly to the first, by 

placing the 3D cursor at the desired location and clicking 

‘Place Screw Hole’ on the side panel. During the placement 

of every screw after the first, three constraint points are 

created between the center points of the screws. The 

constraint points are placed to keep the virtual plate 

dimensionally accurate while allowing for bending along the 

surface of the pelvic model. The three constraint points 

coupled with the center point of each screw create five 

total points, or four segments, between each screw.  
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Figure 10 - Comparing Software Constraint Points to Physical 

Plate. The top figure shows the constraint points in the software 

with red spheres to emphasize their location. The bottom photo 

shows where these constraint points would be located on an actual 

plate (red circles) and the 4 segments that are dimensionally 

controlled (while lines). 

 

Each segment is locked to be the total spacing between 

screw holes divided by four. {picture of a real plate might 

help here with overlaid dots to show where the constraint 
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points are; maybe a picture of the process in Blender as 

well}. 

 

𝑆𝑐𝑟𝑒𝑤 𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑖𝑛 𝑃𝑙𝑎𝑡𝑒

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠
= 𝐿𝑒𝑛𝑔𝑡ℎ 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡               (2) 

 

13𝑚𝑚

4
= 3.25𝑚𝑚     (2) 

 

The creation of these points for a plate with hole spacing 

of 13 mm is as follows: After the second screw hole is 

placed and the 1.5mm ‘shrinkwrap’ constraint is applied to 

it, a line is drawn between the first and second screw 

holes and the midpoint of that line is calculated. This 

midpoint is redefined as “Empty 2”. Empty 2 has the 

‘shrinkwrap’ constraint applied to it with an offset of 

1.5mm from the surface of the pelvis. A new line is now 

created between the first screw hole and the partially 

constrained Empty 2 and the midpoint of that line is 

calculated. This midpoint is redefined as “Empty 1” since 

it is the closest constraint point to the first screw hole. 

Empty 1 has the ‘shrinkwrap’ constraint applied with an 

offset of 1.5mm from the pelvis’ surface and a distance 

constraint of 3.25mm applied between itself and the center 

of the first screw hole. Empty 2 now has a distance 
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constraint of 3.25mm applied between itself and Empty 1. A 

third midpoint is calculated between the fully constrained 

Empty 2 and the initial location of the second screw hole. 

This midpoint is defined as “Empty 3” and is the closest 

constraint point to second screw hole. This midpoint has 

the same ‘shrinkwrap’ constraint applied as the other 

points and has a distance constraint of 3.25mm applied 

between itself and Empty 2. Finally, the second screw hole 

location center point has a distance constraint of 3.25mm 

applied between itself and Empty 3 and distance 

constraining between the screw holes is now finished. Using 

this method, the virtual plate can be placed over almost 

any surface while retaining a high level of dimensional 

accuracy between itself and the physical reconstruction 

plate. In the above description, the hole spacing was 

assumed to be 13mm which is the default value. However, 

this value can be modified within the side panel to be made 

compatible with any reconstruction plate the user might 

have. Assuming the distance between the midpoint of final 

hole and the end of the plate is equal to half the distance 

between each screw hole {picture of a plate to emphasize 

this}, the distance between screw holes can be calculated 

as seen in Equation 2. 
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 Subsequent screw holes can be placed until the 

user is satisfied with the size and location of their 

virtual plate. In some cases, the constraints placed on the 

screw holes will make a more complicated virtual plate than 

would be used in a surgery by fully conforming to the 

surface of the pelvis. In this case, the user can manually 

disable ‘shrinkwrap’ constraints on the screw hole and 

“Empty” points and move the plate as they see fit. As long 

as the distance constraints are kept in place, the virtual 

plate will still reflect the dimensions of the physical 

reconstruction plate. 

   

   5. ‘Hole: ‘.  This input box gives the user the 

option to change the dimensioning of the screw holes. This 

value controls the dimensioning of the segments in between 

each plate and the radius of the circle placed around the 

most recent screw hole. The default value is set to 13mm 

between holes. 

    

   6. ‘Folder: ‘.  This input box gives the user the 

ability to change the folder any outputs will be placed in. 

The software extension has a preliminary file path set that 

the user can edit through simple manipulation of the code. 
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   7. ‘Filename: ‘.  This input box gives the user the 

ability to change the file name of any outputs from the 

software. This value should be changed for each new plate 

that is planned to be built. 

 

   8. ‘Export Plate as .stl’.  This button will save 

the virtual, aesthetic plate as a STL file and then 

reimport it back into the scene. This gives the user the 

option to build multiple virtual plates and templates while 

still having a visual representation of where their 

previously designed plate is located. 

 

   9. ‘Export Screws as .stl’.  When this button is 

pressed, several actions will take place within the 

software. First, the software will activate all vertex 

groups located on the pelvis model. Every time the user 

placed a screw hole, a single triangle face underneath the 

screw hole was selected. Beginning with the second screw 

the user placed, these single triangle faces were connected 

in a line and saved as a vertex group, or group of 

triangles. When the user is ready to export their template, 

all previously created vertex groups become selected and 

this selection region is grown to encompass the area under 

the virtual plate. This selection of triangles is then 
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copied, separated from the surface of the pelvis, and made 

into a solid with the Blender modifier, Solidify. This 

solidified section is extruded down 4mm, all spheres 

representing screw locations are selected by the software, 

and the new solid surface and the spheres exported as a 

single STL file. The software then deletes all spheres and 

constraint points. 

    

   10. ‘Delete Everything’.  This function selects all 

on-screen items excluding the pelvis and deletes them. It 

is used when the user wishes to restart the plate building 

process.  

      

   11. ‘Apply Transforms’.  This button is used to 

calibrate the pelvis to its surrounding environment. If the 

user is only using the template pelvis, this button should 

be used whenever the pelvic model has been rotated or 

translated in the software using the tools seen in Figure 

11. If the user imports their own pelvic model, this button 

should be used before the plate placement process begins. 
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Figure 11 - Rotating and Translating the Pelvis. Use of either of 

these tools will cause the pelvis to become unaligned from its 

surrounding environment. It will not physically look out of place 

but plates that are attempted will not be properly oriented. 

      

 

 
Figure 12 - Unaligned Pelvis Creates Skewed Screw Hole. The 

pelvis in this photo was rotated but the ‘Apply Transforms’ 

function was never used so the screw hole placed on this surface 

is skewed. 
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D. General Process for Template Creation 

 
Figure 13 - Flowchart for Designing a Bending Template. 

 

   1. Obtain Patient CT Data.  Images from CT scans 

are generated in the DICOM format which contains both the 

images and headers with associated information. Images 

obtained from the University of Louisville Synapse database 

often have no file extensions since they are opened in an 

included viewing program. Using the CT stacks beyond the 

included viewing program requires the user to manually add 

the file extensions or use the follow batch code to convert 

them: 

@Echo Off 

ren * *.dcm 

 

These stacks of DICOM images are opened in ImageJ 

through the ‘Import’ -> ‘Image Sequence...’ menu. Before 

performing any further steps, the user should verify the 

voxel dimensions in the image stack through ‘Image’ -> 
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’Properties’ and making note of ‘Pixel Width’, ‘Pixel 

Height’, and ‘Voxel Depth’. These values will be needed 

later to ensure an accurate 3D reconstruction in performed.  

 

   2. Segmenting the Image Stack.  Segmentation is the 

process of extracting the tissue of interest from the 

surrounding tissues. For this thesis, bone was the tissue 

of interest and threshold segmentation was performed. In CT 

scans, pixels in the image are assigned a grayscale value 

from 0 to 255. The pixels representing the least dense 

tissue, usually air, are assigned a value of 0, or pure 

black. The pixels representing the densest objects, usually 

bone or titanium, are assigned a value of 255, or pure 

white. The pixels representing other tissues in the image 

will be assigned a value between 1-244 that is a shade of 

gray. In threshold segmentation, a threshold value is set 

to determine what tissue to keep and what tissue to ignore. 

This creates a binary image by setting any pixel below the 

threshold value to 0 and any pixel above the value to 255.  

The process itself is somewhat subjective and other 

factors, such as the partial volume effect, play a role in 

making it difficult. The partial volume effect occurs in CT 

scans when very dense tissue is located next to much softer 

tissues. Because the resolution of the image obtained in a 
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CT scan is limited, it is possible for density transitions 

to occur within the boundaries of the pixel. When this 

occurs, the computer will average the densities of the two 

tissues and assign that color to the pixel. During 

segmentation, this can create difficulties because the 

computer may not have the resolution to recognize that a 

boundary exists between two fragments of a bone or a joint.  

For all image stacks processed in this thesis, a threshold 

was chosen to balance the intact hemipelvis being 

completely enclosed with the reduction of noise. This 

method is easily verified within ImageJ by using the ‘fill 

hole’ function and verifying that the intact hemipelvis has 

been filled in on all slices of the stack.  

 

   3. Edit Image Stack to Isolate Hemipelvis.  After 

segmentation, the goal is to obtain the intact hemipelvis 

so that it can eventually be mirrored and used as the 

reconstructed pelvis on which the plate can be bent. The 

partial volume effect complicates this process as it makes 

individual bones often appear as if they are connected. 

This is common at the sacroiliac (SI) joint between the 

iliac wing and the sacrum of the pelvis. To separate the 

iliac wing, the paintbrush effect is used to manually erase 

white pixels from the joint space. This method does not 
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compromise the accuracy of the pelvis since material can be 

preferentially removed from the sacrum to disconnect the 

two bones. Additionally, the iliac wing portion of the SI 

joint is not a location for reconstruction plates making 

any material removed from it inconsequential. Another 

method for separating bones involves eroding the image. 

During erosion, a single pixel is deleted from the 

perimeter of all objects, making it an excellent way to 

remove noise from the image while not compromising 

important structures. After the bone of interest is 

extracted, it will be dilated to bring the bone back to its 

original size.  

 

   4. Extract Isolated Hemipelvis.  After segmentation 

and initial edits within ImageJ, the stack of CT images is 

saved as a TIFF file. This TIFF file is then opened in 

MATLAB and edited using the previously described function. 

After the intact hemipelvis has been separated, any 

erosions performed in ImageJ or MATLAB are corrected with a 

similar dilation. 

 

   5. Convert Hemipelvis to STL Model.  The isolated 

hemipelvis can now be opened in Slicer to convert it from a 

stack of binary images into a STL file. The TIFF file is 
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imported through the ‘Load Data’ button while in the 

‘Welcome to Blender’ module. To confirm the correct 

dimensions of the voxels are being used, the user should 

change the dimensions in the ‘Volumes’ module under the 

‘Volume Information Tab’. Slicer assumes that all imported 

volumes are isotropic with 1mm dimensions. This should be 

changed by the user since most clinical scans will have 

length and widths of 0.488mm and can range from 0.5mm-3mm 

in height. This information can be obtained from a DICOM 

image stack in ImageJ as described before. With the proper 

dimensions applied, the image stack is rebuilt as a 3D 

model. The user can now enter the ‘Editor’ module and 

should confirm the default label map. The user will have to 

threshold the image again by pressing the ‘ThresholdEffect’ 

button. Since the image imported is 8-bit and already 

binary, the lower threshold range should be 1.0 and the 

upper should be 255.0. The user now should click ‘Apply’ 

and then ‘MakeModelEffect’. The user should specify a new 

model name, ensure the ‘Smooth’ box is checked, and click 

‘Apply’. There will now be a model of the pelvis in the 

upper right screen. The user can export this model through 

the ‘Save’ button, de-selecting all items, and reselecting 

only the file with the model name the user specified and a 

“.vtk” extension. The user should use the drop-down menu to 
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change “.vtk” to “.stl”, specify the output directory, and 

press ‘Save’. With the STL model created, the pelvis can 

now be opened within Blender and the extension can be used 

to build a virtual reconstruction plate. 

 

   6. Build Virtual Plate in Blender.  The STL file of 

the intact pelvis should be imported into Blender through 

‘File’ -> ‘Import’ -> ‘.stl’. Once imported, the user will 

need to manually rename their pelvic model to “Pelvis” 

under the Scene tab on the right-hand side of the screen. 

Much of the software’s underlying process involves 

referring to an object named “Pelvis” and a lack of that 

object will prevent the software from working properly. 

After importing the desired pelvis model, it is wise to use 

the ‘Apply Transform’ button included in the side panel to 

ensure that the new pelvis is properly aligned. The user 

can adjust their view of the pelvis by holding the middle 

mouse button. Occasionally, the user will not be to obtain 

the desired view through the mouse alone and the model 

itself will need to be rotated. {image showing how to do 

this.} If the model is rotated using this method, the 

‘Apply Transforms’ button must be clicked to reorient the 

software. 
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   If desired, facture lines can be transferred to the 

intact pelvis using the Grease Pencil utility. To place a 

fracture line after the pelvis is imported, orient the 

pelvis so that the desired surface is easily accessible. 

Open the Grease Pencil side panel, check the box labeled 

‘Continuous Drawing’, and select ‘Surface’ under the Stroke 

Placement header. To change the Grease Pencil color, Press 

‘N’ on the keyboard to open the settings menu, press the 

‘New Layer’ button under the Grease Pencil Layers header, 

click the black box under the Tint header and slide the bar 

next to R to make the line red. When ready to place the 

fracture line, the user should click the ‘Draw’ button 

under the Draw header in Grease Pencil side panel. Lines 

can now be drawn onto the surface of the pelvis to 

represent the location of fracture lines. When done, the 

user can click anywhere outside of the window to stop 

drawing.  

   When ready to place the virtual plate, the user 

should open the Pelvis side panel. The user can then place 

the 3D cursor at the desired location and press the ‘Place 

Screw Hole’ button to begin construction of the virtual 

plate. If at any point the user wishes to remove the last 

screw hole placed, they can press CTRL-Z to undo their last 

action. If the user wishes to restart, they may press the 
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‘Erase Everything’ button located in the Pelvis side panel 

to remove everything except the pelvis and any drawn 

fracture lines.  

 

   7. Export Virtual Bending Template.  When the user 

is ready to export the newly created template, they should 

press the button labeled ‘Export Screws as .stl”. If the 

user only needed to create a single template, they should 

now save the file through ‘File’ -> ‘Save as...’ and may 

close Blender. If the user wishes to create a second 

template on the same pelvis, they should press the button 

labeled “Export Plate as .stl”. The plate visible on the 

pelvis is now a static object that cannot be edited 

further. The user should change the value located in the 

‘Filename’ box on the side panel and can then begin to 

build subsequent plates.  

 

   8. Post-Processing of Virtual Template.  After 

saving the temple from Blender, the user should open the 

template in Meshmixer for final processing. The object 

should be oriented with the spheres and pelvis surface 

facing upward by using the ‘Edit’ -> ‘Transform’ tool. The 

user should also take advantage of the ‘Analyze’ -> 

‘Inspector’ tool to ensure there are no structural flaws 
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with their part. If the tool reports the spheres as 

problems {image} the user should not click “Auto Repair 

All’ and should instead manually click through the repair 

features, ensuring that the spheres remain intact. The user 

can perform additional editing to the object by extruding 

surfaces to make the template easier to handle while in the 

operating room{image}. When the user is satisfied with the 

condition of their STL template, it can be exported from 

Meshmixer using ‘File’ -> ‘Export’. 

 

   9. Preparing Template for Printing.  To print the 

bending template, the user should open Preform. The user 

will need to confirm the printer and correct material are 

being used. For this thesis, the printer being used is 

always the Form 2. If the part is being printed for non-

clinical uses, then any material may be used. If the part 

is being tested for clinical use, only Dental SG should be 

used. The user can press ‘Apply’ to confirm settings and 

bring up their build tray. To import their template, the 

user will have to drag their template file to the build 

tray. The user can then modify the orientation of the 

template if necessary to ensure the spheres and pelvis 

surface are facing upwards. The user should confirm support 

structure through ‘Supports’ -> ‘Generate All’ located on 
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the left-hand panel. Finally, the user should connect their 

computer to the Form 2 printer, save their print file in 

“.form” format, and press the orange ‘Start a Print’ 

button. This will bring up a window for the user to select 

their printer and confirm their action. The USB cable 

connecting the user’s computer and the Form 2 printer can 

now be disconnected. The user can now use the control 

interface on the printer to start the print.  

  

   10. Post-Processing of Physical Template.  After 

the print is finished, the user may remove the print 

platform from the printer and remove the part from the 

print platform. The part should then be washed in IPA for 

10-20 minutes and transferred to a UV curing station for 

10-30 minutes. After curing, the part is removed from the 

curing station and support structures are removed [39]. 

 

   11. Sterilization and Bending.  If the part was 

printed in Dental SG and is intended to be used clinically, 

it should be sterilized before entering the operating room. 

Sterilization of the template can be done using an 

autoclave and one of three possible time/temperature 

combinations. Acceptable combinations are as follows: 134°C 

for 6 minutes, 121°C for 15 minutes, or 138°C for 3 
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minutes. The part should be kept free of particulate 

contamination between printing and sterilization and should 

only be sterilized using the autoclave available in the 

surgery department that the template will be used in. After 

the template is used for bending, it should be washed and 

re-sterilized before dimensional verification.  

 

B. Proof of Process and Size Verification 

 

The following work was done validate that the process 

of creating a bending template from CT data and using it to 

accurately bend a plate.  

The CT scan data used to create the template pelvis 

for this proof of process was obtained from the Laboratory 

of Human Anatomy and Embryology, University of Brussels 

(ULB), Belgium. The scan took place in 3 sequences: 

Crest/Ilium, Acetabulum, and Ischium/Pubis. For all 

sequences, the images were 512x512 pixels with each pixel 

representing a square of 0.488mm. For the crest/ilium and 

ischium/pubis sequences, slice height was 1mm. For the 

acetabulum, slice height was 0.5mm. ImageJ was used to 

rebuild the three sequences as a single file. For the 

crest/ilium and ischium/pubis sequences, the images were 
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resized to double their normal length with no 

interpolation. The product of this was that, for these two 

sequences, each slice was duplicated but all files could 

now be combined and reconstructed with a slice height of 

0.5mm. The files were then concatenated in ImageJ, 

converted to 8-bit, and segmented at a threshold of 37. To 

remove noise, the entire stack was eroded once in ImageJ.  

   

   The TIFF stack was then imported into MATLAB and 

the left iliac wing was isolated from the remaining noise. 

No morphological operations were performed in MATLAB. The 

text output of the process used to extract the pelvis from 

surrounding noise is located in Appendix I. After the 

pelvis was isolated, it was brought back into ImageJ and 

dilated to bring it back to its original size. This TIFF 

stack was then imported into Slicer to create a STL model 

of the pelvis. The dimensions were adjusted to have a 

length and width of 0.488mm and a height of 0.5mm. After 

adjusting the dimensions, the threshold limit was set to 

1.0 and ‘MakeModelEffect’ was used to convert the model 

into a solid body. After the conversion, the STL file was 

exported through ‘Save’ and changing the default ‘.vtk’ 

format to ‘.stl’. 
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 The STL file of the pelvis was then opened in Blender, 

oriented, and the ‘Apply Transforms’ button was used to 

properly align the model. Figure 14 shows the input from an 

orthopedic trauma surgeon detailing where a posterior wall 

and an ilioinguinal plate should be placed and the virtual 

plates created within the software.  

 

 

  
Figure 14 - Surgeon Specified Locations of Plates. The 

‘GreasePencil’ tool was used to annotate the locations of the 

Posterior Wall (left) and Anterior Brim (right) plates. 

  

These plate locations were chosen because posterior wall 

plates often have the most complex geometries and 
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ilioinguinal plates are capable of displacing reduced 

fragments if they are not properly bend before being 

secured. The surgeon specified that posterior wall plates 

are often 6-8 holes and ilioinguinal plates are 8-10 holes 

depending on the patient’s gender and size. 

 

 
Figure 15 - Surgeon Specified Posterior Wall Plate. 

 

 
Figure 16 – Surgeon Specified Anterior Brim Plate. 
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   The bending templates from these plates were 

exported from Blender and opened in Meshmixer for final 

processing. In Meshmixer, holes in the mesh were filled, 

portions of the mesh were smoothed, the part was 

reoriented, and a stand was created for the parts so that 

they could be set upright. The vertical portion of the 

stand was created by placing circular stamps and extruding 

them down. The bases of the templates were created using 

Solidworks. Figure 17 shows the bounding box of the two 

plates and Table I shows the dimensions of the plates and 

the dimensions of their corresponding base plates. By 

creating a base with similar dimensions to that of the 

template, the base itself can be measured for dimensional 

accuracy. 
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Figure 17 – Pre-Processed Bending Templates with Dimensional 

Bounding Box. The Posterior Wall template is positioned on top 

and the Anterior Brim template is positioned on bottom. 

 

 

Table I - Dimensions of the Plates and Bases 

 Meshmixer 

Length 

(mm) 

Meshmixer 

Width (mm) 

Baseplate 

Length 

(mm) 

Baseplate 

Width (mm) 

Posterior 

Column 

88.25 29.30 88.00 29.00 

Anterior 

Brim 

104.78 31.84 104.00 31.00 
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Figure 18 - Post-Processed Posterior Wall Virtual Template. This 

image shows the bending template with its vertical support and 

baseplate before the single error was repair and it was exported 

from Meshmixer. Meshmixer often attempts to classify the screw 

landmarks as mesh errors. 

  

After the bending templates had been modified in 

Meshmixer, they were imported into Preform. The print slice 

resolution was set to 50μm and the material used was Clear. 

An isotropic 15mm cube was also included in the build tray 

for further dimensional verification of the parts. To 

conserve material, only the posterior wall plate was 

printed. Since the posterior wall has the most complex 

bends, this represents the worst-case scenario of a bending 

template that would need to be made. Location of the 
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template and the cube within the build tray can be seen in 

Figure 19.  

 

 
Figure 19 – Two Views of the Build Tray. The left image shows the 

location of the two parts on the build tray. The right image 

shows the support material needed for the part to print 

successfully. 

 

   After the build finished, all parts were washed in 

isopropyl alcohol baths for 10 minutes. Parts were then 

placed in a UV curing station for a total of 30 minutes. 

After curing, the support structures were removed and the 

dimensions of the base of each template and the 3 faces of 

the calibration cube were measured. Finally, reconstruction 

plates were bent by an orthopedic surgeon using the bending 

template as a guide. 
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Figure 20 - Template in UV Curing Station. 

C. Segmentation Threshold and Size of Pelvis 

    For this work, segmentation of the bone from 

surrounding bone was done using threshold segmentation. For 

the proof of process bending template design, a threshold 

was chosen so that the cortical bone was a single, enclosed 

entity. Confirmation of the correct threshold was confirmed 

using the ‘fill’ feature in ImageJ and ensuring the entire 

area within the cortex of the bone was filled in all images 

within the stack. For the proof of process, a threshold of 

37/255 was used. This method produced adequate results but 

is inherently very subjective. Additionally, other users 

may wish to use higher threshold values in order to remove 

noise or lower threshold values in order to capture thin 

features of bone. These variations in threshold value will 

result in slight changes to the morphology and size of the 

reconstructed pelvis due to the partial volume effect. To 
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account for users who may choose to use a lower or higher 

threshold value than that described in this work the pelvis 

was segmented at different threshold values, reconstructed 

as an STL file, and differences between the models were 

examined. Additionally, the model used for the proof of 

process was actually composed of 3 CT scans. Two of the 

scans, the most superior portion of the pelvis, the iliac 

crest and the most inferior portion, the ischium, were done 

using 1.0mm slice thickness and the acetabulum was done 

using 0.5mm slice thickness. This provided a very accurate 

model for our work but is not representative of the 3mm 

scans that are often used for diagnosing pelvic fracture. 

For this reason, we will compare the reconstruction of the 

1mm and 0.5mm slices at the original threshold of 37 with a 

3mm slice of the same pelvis. In order to create 3mm 

slices, only every third slice will be used in the 1.0mm 

scans and only every sixth slice will be used in the 0.5mm 

scan.  

A total of three segmentations were performed at 31, 

37, and 43. 37 was chosen since it was used for the proof 

of process model and 31 and 43 were chosen since they were 

six units below and above respectively. All three models 

were reconstructed using the 1mm and 0.5mm slices and the 

threshold 37 model was additionally reconstructed as a 3mm 
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slice thickness model. The fill feature was used on all 

image stacks and stacks containing voids were manually 

repaired to create a continuous, enclosed feature. 

Reconstruction of the image stacks to STL models was 

performed within Slicer, pixel dimensions were 

0.488mmx0.488mm and voxel height was 0.5mm for all slices 

except the 3mm reconstruction. After reconstruction, the 

differences between the models were compared using 

CloudCompare. The STL models are imported into CloudCompare 

and are resampled to allow for the greatest accuracy in 

distance detection. Resampling is done through ‘Edit’ -> 

‘Mesh’ -> ‘Sample Points’ and 1,000,000 points were used. 

After both objects had been resampled, they were aligned to 

each other through ‘Tools’ -> ‘Registration’ -> ‘Fine 

Registration (ICP)’. This registration method required that 

one model be set as the ‘Aligned’ and the other as the 

‘Reference’. For this work, both models were tested in both 

roles to determine if aligned would play a role and the RMS 

value, or the accuracy of the alignment, is reported. After 

alignment, both objects were selected and the distance 

between the points of each cloud were calculated using 

‘Tools’ -> ‘Distances’ -> ‘Cloud/Cloud Dist.’. The results 

are more accurate when the ‘Compared’ object is set as the 

larger of the two objects and the ‘Reference’ object is the 
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smaller. However, since the pelvis is a complex model, both 

models were used in both roles and the results of each were 

recorded. For the comparison of pelvis models, each 

comparison was done four times to allow both models to 

serve as the ‘Aligned’ and ‘Compared’ Models. The software 

reports the average distance that the two objects deviate 

by but also organizes the data into distance bins that 

allow the user to see relatively how many points deviated 

by certain distances. The software also reports minimum and 

maximum distances.  

To illustrate how this software works two cubes, A and 

B, were created with 10mm and 12mm side lengths 

respectively. Figure 21 shows the two cubes as points 

clouds aligned with both their centers at point (0,0,0). 

 

 
Figure 21 - Two Cubes Aligned. Showing the green box of Cube A, 

10mm, inside the gray point cloud of Cube B, 12mm. 

 



 

60 
 

Before the distance calculations are run through the 

computer, several distances can be calculated by hand. In 

Figure 22 we see a two-dimensional representation of how 

the cubes are positioned in one another. 

 
Figure 22 - Cubes A and B as Squares. Cube A, 10mm, and Cube B, 

12mm both have their center at (0,0). The two black boxes show 

the dimensions, in mm, between the walls and the corner points of 

the two squares. 

 

Equation 3 shows that since cube A and cube B have the same 

center, the distance between their parallel walls can be 

calculated as 1.0 mm. Equation 4 shows how Pythagorean’s 

theorem is used to calculate the distance between the edges 

of the two cubes as approximately 1.41 mm. Finally, 
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Equation 5 uses Pythagorean’s theorem to calculate the 

distance between the corner vertices of the two cubes as 

approximately 1.73 mm.     

(10.0 – 12.0)

2
= 1.000 𝑚𝑚                     (3) 

√(5.0 − 6.0)2 + (5.0 − 6.0)2 =  √2 = ~1.414 mm              (4)     

√(5.0 − 6.0)2 + (5.0 − 6.0)2 + (5.0 − 6.0)2 =  √3 = ~1.732 mm         (5)     

 

    With these known distances, we can now better 

understand the output that the software provides. Figure 23 

shows a histogram of the distances and Figure 24 shows the 

complete colormap as well as the previously calculated 

distances emphasized. Table II shows the parameters for 

this example. It was assumed that since both objects were 

isotropic cubes, the object assigned as ‘Align’ would not 

make a large difference and this is confirmed with the 

resulting RMS values of 1.00. The data represented in 

Figures 23 and 24 are highlighted in yellow in Table II.   
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Figure 23 - Histogram of the Distances Between Points. 

 

 
Figure 24 - Montage of Distance Colormap. ‘A’ shows the entire 

colormap on the larger cube, ‘B’ shows distances of 1.0–1.1 mm, 

‘C’ shows distances of 1.30-1.45 mm, and ‘D’ shows distances 

1.45-1.75 mm. 
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Table II - Parameters of the Cube Example. 

     
CloudCompare reported the average distance between 

cubes as 0.9999±0.0235mm and the maximum distance as 1.750. 

The circled portions in Figure 24 show that the output from 

the software agrees well with our previously calculated 

values. It is possible that the reported maximum distance 

did not perfectly agree with our calculated maximum 

distance of 1.732 mm because of the process of resampling 

the STL file into a point cloud. The data in Table II 

confirms that the ‘Compared’ model plays a large role in 

obtaining accurate measurements. The maximum distance 

reported when the 10mm cube was the ‘Compared’ model was 

1.06mm, far lower than our calculations showed. Knowledge 

of how CloudCompare calculates and displays distances will 

allow for easier interpretation when the pelvic STL models 

are compared.  

  

aligned reference compared reference RMS avg (mm) std dev (mm) max (mm)

10mm 12mm 10mm 12mm 1.0026 0.9999 0.0235 1.0569

10mm 12mm 12mm 10mm 1.0027 1.0495 0.109 1.7503
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IV. RESULTS 

 

A. Initial Plate Designs 

    Iterations of bending templates for the posterior 

wall plate and pelvic brim can be seen in Figure 25. A 

reconstruction plate bent to match one of the later 

iterations in seen in Figure 26.  

 

 
Figure 25 - Several Initial Bending Templates. 
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Figure 26 - A Reconstruction Plate Bent to an Initial Bending 

Template. 

 

    The initial template designs revealed several flaws 

within their construction including the dimensions and 

structure of the screw landmarks. Other feedback included 

the desire for the plate to be free standing such as seen 

in Figure 26. The bent plate shown in Figure 26 does not 

fully conform to the plate but was an initial bending 

attempt and not performed by an orthopedic surgeon.  

B. Proof of Process and Size Verification 

 

   The physical bending template for the posterior 

wall plate, the reconstruction plate contoured to the 

templates, and the dimensions of the virtual and physical 

plate bases and calibration cubes can be seen in Figures 27 

and 28 and Table III respectively.   
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Figure 27 - Proof of Process Bending Template and Isotropic Cube. 

 

 

 

 
Table III - Comparison of Designed and Measured Dimensions. 

 
 

 The plate bending was performed by an orthopedic 

surgeon so it can be assumed that the plate was correctly 

bent. When examining the dimensions of the printed parts, 

four of the six measurements fell below 1% error. The Z, or 

height, measurement of the cube had over 20% error. This 

error is believed to be due to the nature of the uncured 

polymer present and the density of the support structures. 

After being printed, the part was washed in IPA to dissolve 

the uncured liquid resin that is in excess on that part. In 

Part Direction Specified (mm) m1 (mm) m2 (mm) m3 (mm) m_avg (mm) m_std dev (mm) % Error

X 29.00 29.17 29.18 29.09 29.1466667 0.040 0.51%

Y 88.00 88.18 88.36 88.29 88.2766667 0.074 0.31%

Z 4.00 5.13 4.62 4.82 4.85666667 0.210 21.42%

X 10.00 10.11 10.13 10.13 10.1233333 0.009 1.23%

Y 10.00 10.09 10.08 10.08 10.0833333 0.005 0.83%

Z 10.00 10.19 10.25 10.17 10.2033333 0.034 2.03%

Posterior 

Wall 

Plate

Isotropic 

Cube
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this case, the quantity of support structures present 

between the base of the bending template and the printing 

tray and the very low height created an environment in 

which the IPA could not adequately flow through to remove 

the resin. It is probable that some excess resin was still 

present in this location during the curing process and so 

this excess resin, instead of being removed from the part 

as it was in other locations, cured and became joined to 

the bending template. If we examine the same dimension in 

the isotropic cube, there is only an error of 2%, showing 

that this was not a print failure but instead was caused by 

inadequate post-processing. In the future, placing the base 

of the bending template directly on the printing platform 

without support material in between or defining a greater 

support height may provide a more accurate print with fewer 

places for uncured resin to remain. 

 

 

 

 

 
Figure 28 - Bending Template and Contoured Plate. 
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C. Segmentation Threshold and Model Size 

    A total of three segmentations were performed, 31, 

37, and 43. All models were built using the 1mm and 0.5mm 

slice thickness. Additionally, the threshold 37 model was 

rebuilt with 3mm slices. Table IV shows the relevant 

comparisons of the models with their average and maximum 

deviations. Data of all performed comparisons is available 

in Appendix B. As seen in Table II, the initial comparison 

of the Threshold 37 model that had 1mm and 0.5mm slice 

thickness (named “T37-fc-Before”) vs. the Threshold 37 

model with manually created 3mm slice thickness (named 

“T37-3mm-Before”) had a large maximum distance. Figure 29 

shows where these large deviations were physically located 

on the model. 
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Figure 29 - Locations of Large Distance Deviations. The wing of 

the ilium (Top) and the ischial spine (Bottom) with distance 

deviations greater than 1.5mm highlighted in red, yellow and 

green on the left images. The defect in the ischial spine is due 

to the removal of the sacrospinous ligament and the defect of the 

ilium wing is most likely the result of soft tissue that wasn’t 

fully removed. 

 

As seen, this error is not due to large differences in the 

manner of reconstruction but instead due to noise and 

unfilled sections on the pelvic model. In order to reduce 
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the error associated with this noise, manual editing of the 

images was performed as seen in Figures 30-32, the models 

were reconstructed (named “T37-fc-After” and “T37-3mm-

After”) as seen in Figure 33, and the comparisons were 

performed again.  

 
Figure 30 - Repair in T37 Slices 62-65. A-C and D-F show slices 

62-65 before and after noise removal respectively. B represents 

the identical slices 63 and 64 before editing and E represents 

the identical slices 63 and 64 after the editing. 
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Figure 31 - Repair in T37 Slices 122-125. A-C and D-F show slices 

62-65 before and after noise removal respectively. B represent 

the identical slices 123 and 124 before editing and E represent 

the identical slices 123 and 124 after the editing. 

 

 
Figure 32 - Repair in T37 Slices 242-264. A-C are photos of three 

slices before editing and D-C are photos of the same slices after 

editing.  
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Figure 33 - Before and After Noise Removal. Left-hand images show 

the model before and right-hand images show the model after noise 

removal and defect repair. 

 

 

Table IV - Relevant Distance Values from Model Comparison 

 
  

aligned reference compared reference RMS
avg 

(mm)

std dev 

(mm)

max 

(mm)

T37-fc Before T37-3mm Before T37-fc Before T37-3mm Before 0.5596 0.1797 0.1358 2.5697

T37-3mm After T37-fc After T37-fc After T37-3mm After 0.5543 0.1777 0.1289 1.3776

T31 T37-fc-Before T37-fc-Before T31 0.5271 0.1113 0.0582 1.9958

T43 T37-fc-Before T37-fc-Before T43 0.5224 0.1087 0.0499 2.5322

T31 T43 T31 T43 0.5335 0.1309 0.0721 2.6379
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V. DISCUSSION 

  

A. Comparison to Current Literature 

    

   3D Printed models in orthopedic surgery have 

increased the ability of surgeons to plan for complex 

surgeries through direct visualization of fracture patterns 

and advanced personalized medicine by allowing surgeons to 

pre-bend plates according to the patient’s own anatomy. 

However, all current 3D printed models suffer the severe 

drawback in the amount of time required to print a full-

scale model and, if they are being taken into the operating 

room, the time required to sterilize them. Methods that 

involve contouring the plate outside of the operating room 

before the surgery still suffer from large time delays 

since the plate must go through a very lengthy 

sterilization process to be implanted. Additive 

manufacturing in titanium is the pinnacle of personalized 

medicine and patient specific plates but the current 

regulatory environment restricts it from being used 
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consistently. Virtual planning software provides even 

better surgical planning methods than physical models by 

allowing the surgeon to practice steps of the surgery on 

the patient’s anatomy beforehand. However, most surgical 

planning software does little to assist the surgeon in the 

operating room besides the practice provided. Chen et al.’s 

recent use of MIMICS provides the best combination of 

surgical planning and physical outputs with the creation of 

a screw guide and template. Our process allows the surgeon 

to build the plate, screw by screw, utilizing the existing 

anatomy and location of fracture lines. As our plate is 

build, constraints guide the placement of subsequent screws 

and screw holes. Since our work in intended to be done with 

locking plates, the orientation of the plate itself guides 

where the screws will be placed. Additionally, their 

methods would not have allowed for an accurately 

dimensioned plate or screw locations if they had performed 

their process on more complex anatomy than the anterior 

brim. Their plastic implant was also not manufactured in a 

way that it would have been feasible to use on a live 

patient. 
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B. Design Choices in the Blender Extension 

 

   1. Bending an STL Model of a Plate.  One of the 

initial iterations of the software was designed to function 

similarly to what Derand et al. described when they 

deformed an STL model of the reconstruction plate around a 

virtual model of the mandible [26]. During this iteration, 

a simple six-hole plate was designed in Solidworks with 

similar dimensions to a Stryker six-hole reconstruction 

plate. The user would place the 3D cursor on the pelvis, 

press the ‘Import Plate’ button on the side panel, the 

plate would be imported with its midpoint at the 3D cursor 

location, and would be oriented based on the normal vectors 

of the surrounding triangles. Along with the plate, a 

lattice would be created in Blender which would be skinned 

to the pelvis. The lattice was necessary to get to the 

plate to accurately contour to the pelvis since several 

modifiers are available in Blender that allow accurate 

movements of STL files to be determined by a lattice 

structure. Once the user imported the lattice file, they 

would be able to use the left and right direction keys to 

rotate the plate and lattice together and the plate would 

contour to the pelvis as it rotated. The size and 

resolution of the lattice structure could be controlled in 
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all three dimensions. Increasing the height dimension often 

created poor results but increasing the width of the 

lattice structure enabled the plate to make realistic 

twisting motions. Increasing the resolution, or number of 

segments, in the length of the lattice controlled how 

accurately the out-of-plane bending was performed. 

 

 

 
Figure 34 - Normal Bending of STL Model of Plate. Even when the 

model bend as designed, the dimensions between holes could not be 

controlled. 
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This initial test mimicked the bending shown by Derand to a 

certain extend but had several key flaws. Firstly, this 

iteration lacked the ability to undergo out of plane 

bending without the user manually dragging lattice control 

points to desired locations. Secondly, dimensional accuracy 

was not able to be controlled after the plate began being 

deformed. Thirdly, the lattice method and thin features in 

the pelvic model combined to cause glitches that could only 

be fixed by the user manually repositioning the lattice 

control points.  

 

 
Figure 35 - Glitches with Pre-Made STL Model of Plate. Portions 

of the plate can be seen ‘falling through’ the pelvis model or 

undergoing severe deformations. 
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Finally, the method in general did not produce a useable 

output. Even if the plate had perfect dimensional accuracy, 

the locations of screws could be changed to allow for 

bending, and the software glitches were resolved, the only 

output of this software would have been a contoured, 

plastic plate. Such a plate would only be useful for its 

aesthetic value since such high barriers exist to 

manufacturing a virtual plate in titanium and implanting it 

in a patient. For these reasons, future work focused on 

designing a system that would capturing the pelvic surface 

features while a user built an aesthetic, virtual plate.  

 

   2. Distance Between Screws.  To create a usable 

bending template, the distance between the screw landmarks 

had to be controlled in a way that would mimic a physical 

plate. Chen’s study focused on a geometrically simple 

location, the anterior brim of the pelvis, and dimensioned 

their screws to be 12 mm apart from one another. Initially, 

the software proposed in this work used a similar method by 

defining the center of each screw hole as a point and 

constraining those points to be 13mm from one another.  
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Figure 36 - Two Point Screw Dimensioning. This image shows how a 

single line segment is used to dimension the distance between two 

screws. 

  

This method will give perfect results on a flat surface and 

adequate results on surfaces with mild curves. As the 

complexity of the surface increases however, only using two 

points to constrain the distance between screws will 

provide increasingly inaccurate results. To overcome this, 

our work incorporated five points with four straight line 

segments for dimensioning. There is no real limit to how 

many points can be included but we felt that diminishing 

returns would be seen after a more than five were included. 

 

   3. Screw Landmarks.  Creating landmarks to show the 

locations of screws is an important component of this work. 

Initial designs were shown earlier and were less than 

Distance 

Constrained by 

single Segment 
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desirable for a variety of reasons. The screw holes in our 

plates were 4.5mm in diameter so the initial landmarks were 

designed to be cylinders with a 4.4 mm diameter. The 

intention was that the user would bend the reconstruction 

plate so that it would sit perfectly on the template 

surface and all cylinders would be fully seated in the 

screw hole locations as seen in Figure 37. 

 

 
Figure 37 - Virtual Plate Overlaid on the Bending Template. 

 

This method proved to be problematic once a physical 

bending template was created and physical reconstruction 

plates were countered to it. Firstly, the cylinders fit 

inside the screw holes of the plate as intended while the 

plate was flat but after bending, even with the holes 

protected, small dimension changes made the cylinders 

unable to fit into the screw holes. Secondly, sharp bends 

in the template couple with the size of the cylinders 

resulted in the plate not being able to be placed on the 

template due to physical interactions between the two. 
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   Future attempts included using spheres that were 

less dimensionally restrictive and allowed the surgeon 

flexibility in the angle of their plate. The initial 

testing with these spheres remedied the problems of 

physical interference between the plate and the template 

but did not provide the necessary tactile response when a 

plate had been fully conformed. A final iteration of the 

screw landmark that was not manufactured was a cylinder 

that was 2.5mm in diameter to allow some amount of 

flexibility with plate placement. This design was not used 

due to surgeon preference for the larger spheres. 

C. Future Additions to Software and Process 

 

   1. Additional Blender Features. The software 

extension developed for Blender functions well in its 

current state but further improvements could still be made 

to it. Currently, the software works very well at allowing 

for full control of screw/plate location while still 

keeping the plate dimensionally accurate. A downside of 

this flexibility is that the template created will require 

for more bending and twisting of the plate to create a 

perfect fit than a surgeon would ordinarily perform. The 

final form of the plate will always be determined by the 
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physician but certain additions to the software could make 

the bending process easier. Since many reconstruction 

plates come with no prior bends, the software should take 

this into account and, instead of having small degrees of 

out-of-plane bending between each hole, the software could 

instead attempt to keep the plate as straight as possible 

and create fewer out-of-plane bends with larger angles. 

Other limits to control the amount of twisting or in-plane 

bending that the plate goes through would also be 

advantageous to keep the bending realistic with the 

material properties of the plate.  

In the software’s current iteration, screw landmarks 

are placed at every location that a screw hole would be 

present on the plate. In a surgery however, many of these 

holes are often unused. Allowing the user to disable the 

placement of screw landmarks where they knew they would not 

need screws would allow the user to focus the plate bending 

on the crucial locations were screws would be placed. 

Finally, this software currently accounts for fracture 

lines by the user manually painting them on the surface of 

the model. In its current state, this is still a lengthy 

process and future iterations would add easy methods to 

quickly draw on a fracture line or indicate where they 

would like the plate to be placed. As discussed before, a 
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computer assisted automatic reduction would all the user to 

not only know where the fracture lines were when making the 

model but the divide between two bones would also create a 

noticeable crease when the bending template is printed. 

With a physical representation of the fracture line 

location included with the model, the surgeon would be able 

to more accurately position their plate in the 

predetermined location.  

    

   2. Virtual Fragment Reduction.  One of the most 

personalized surgical planning solutions was shown by 

Cimerman and Kristan [34] in which the individual bone 

fragments were separated so that the fracture could be 

virtually reduced. Other authors have proposed similar 

systems for mandible [42], pelvic fracture [43], [44], and 

long bone [45], [46] repair. This work initially included a 

similar method that involved manual segmentation and 

reduction of all fracture fragment. Similar to the methods 

currently used in this work to separate the intact 

hemipelvis from the rest of an image stack, manual editing 

and erosions could be used to separate fracture fragments. 

The MATLAB software described earlier was originally 

intended to separate multiple fragments of interest and 

many of its features were designed for the purpose of 
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fragment extraction. After being separated and rebuilt as 

STL models, the fragments could be imported into Blender 

and the translation and rotation options available within 

the software would allow the fragments to be reduced. 

Figure 38 shows an image a pelvis that had its fragments 

separated and reduced within Blender. 

 

 
Figure 38 - Reducing Fracture Fragments in Blender. 

 

This method was highly dependent on having a high-quality 

CT image stack with thin slice thickness to accurately 
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separate the bones. The standard slice thickness for 

orthopedic trauma situations is 3mm and the system was 

tested using 1mm slices. Slices thinner than 3mm are rarely 

needed to diagnose fractures and the increased radiation 

dosage to achieve the required resolution would not be in 

the patient’s best interest. Even with thin sliced images, 

it is difficult to adequately segment the images and 

separate the fragments without removing portions of the 

bone and the manual fragment reduction method is time 

consuming and not intuitive. An extension with Slicer, 

called Virtual Fragment Reconstruction, allows the user to 

input stacks of fracture fragments and a stack of the 

unfractured bone. Using this information, the software will 

automatically realign fragments in a maximization of mutual 

information method. This extension was unavailable during 

the development of this work but, in the future, could 

provide an easy method for automated reduction if a thin 

slice CT is performed. 

 

   3. Machine Assisted Plate Bending.  Spinal fusion 

surgeries require metal rods to be bent to hold the 

patient’s vertebrae in the proper orientation while they 

heal. A 1999 paper described how computers could be used to 

calculate the bends that spinal rods would need to make to 
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accurately conform to the patient and how that information 

could be transferred to a machine to perform the precise 

bending needed [47]. The process of contouring of a 

reconstruction plate is similar to the process of bending a 

spinal rod and a similar, machine controlled, method could 

be used to prevent the surgeon from needing to manually 

bend the plate. This would make the plates more accurate 

since it would eliminate human error and stronger since 

constant bending and readjustment of a plate will weaken it 

and can eventually cause it to fail [48]. 

 

D. Segmentation Threshold and Model Size. Derand [26] 

and Shen et al [33] performed comparisons of bending 

variability between surgeons, nurses and technicians of 

both mandibular and pelvic reconstruction plates. Derand 

found that there was 1.2-1.3mm mean difference between 

mandibular plates bent by surgeons and Shen et al showed 

median differences of 0.26-0.80mm between pelvic 

reconstruction plates bent by surgeons, nurses and 

technicians. For this work, differences of over 1.0mm 

between models were considered significant. Although all 

maximum distances presented in Table IV were above the 

1.0mm threshold, almost all of those maximum differences 

were at either the noise/defect locations already shown in 
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Figure 29, at the very top of the iliac wing as seen in 

Figure 40, at the very bottom at the ischial tuberosity, or 

at other miscellaneous overhang locations as seen in Figure 

41. The only significant location of deviation that came 

close to the 1.0mm threshold in all models was between 

“T37-fc-After” and “T37-3mm-After” at a location were an 

anterior brim or pubic symphysis plate would be placed. The 

distance was approximately 0.9mm and is shown in Figure 39. 

Otherwise, no significant deviations occurred at locations 

where anterior brim, ilioinguinal, posterior column, or 

posterior wall plates would be placed.  

 

Figure 39 - Maximum Deviations at Plate Locations. Showing the 

front (Left) and back (right) of the iliac wing. 
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Figure 40 - Maximum Deviations at Insignificant Locations.  

Deviations larges than 1mm at the very top of the iliac wing 

(left) and overhangs and the bottom of the ischial tuberosity 

(right). 

E. Patient Study 

 

    It was not possible to incorporate a patient study 

into this thesis work however, using a patient’s CT data to 

design their reconstruction plate is the logical next step. 

Most scans taken during pelvic trauma are 3mm in thickness. 

This work has shown that no significant deviations exist 

between models constructed with very thin slices, 0.5-

1.0mm, and those constructed from 3mm slices. Additionally, 

the orthopedic surgeon will always have the final decision 

in how a plate is bent before it is implanted in the 

patient. Sterilization was mentioned in this work as a step 
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in the process but was not able to be performed for the 

proof of process. However, minimal logistic or financial 

barriers exist to printing the plate in an autoclavable 

material and flash sterilizing it in the OR suite’s 

autoclave before it is used in the operating room. Recorded 

outcomes of the surgery would be the operative time, blood 

lost by the patient, time required by the surgeon to bend 

the plate, additional time required to create the template, 

the quality of the final reduction, and a qualitative 

analysis of how helpful or burdensome the creation and use 

of a bending template was for the surgery. As the patient 

returns for follow up, infection, other adverse events, and 

how well the plate has maintained the reduction should be 

recorded. While nothing could be statistically proven with 

a single patient case, this study would provide the ground 

work to design further study that could statistically prove 

that the use of a patient specific bending template 

provides better outcomes to the patient.   
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VI. CONCLUSION 

 

 

   This thesis has shown that the patient specific 

pre-bending of plates is an accessible and low-cost 

solution to ensuring patients with orthopedic pelvic 

injuries receive the best possible treatment. Additionally, 

work by other authors has suggested that using pre-bent 

plates can reduce operative time, blood loss, and allow for 

less invasive procedures. Future work should focus on the 

optimization of software, automatic reconstruction of bone 

fragments, streamlining the process to reduce burden on the 

physician, and proving that the process can be performed 

for a patient in a timely manner. Further studies should 

focus on proving that the use of a patient specific bending 

template results in shorter operative times, less blood 

loss, and fewer adverse events to the patient. Further work 

around virtual reduction and automated machine bending will 

further increase the accuracy and specificity of 

reconstruction plate bending and reduce the time needed to 

accurately contour them.  
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VII. APPENDIX 
 

 

A. Text Output from MATLAB During Proof of Process 

The file being edited is: ISB Iliac Wing_T37_Fill_Erode1 

Erode_On = 0 

Erode_Value = 3 

Pixel_Delete_on = 0 

Delete_Value = 100 

Dilate_on = 0 

Dilate_Value = 3 

Connectivity = 6 

Before being edited, this tiff had: 255 total fragment(s) 

Before being edited, this tiff had: 9 fragment(s) larger than: 1000 

voxels 

After being edited, this tiff has: 255 fragment(s) 

After being edited, this tiff has: 9 fragment(s) larger than: 1000 

voxels 

 

C:\HDD-Thesis\Pelvic Models\ISBWEB ILIAC\2 - Image Processing\ISB Iliac 

Wing_T37_Fill_Erode1 9_Fragments 

 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_1.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_2.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_3.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_4.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_5.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_6.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_7.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_8.tif 

ISB Iliac Wing_T37_Fill_Erode1_Fragment_9.tif 

>> 
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B. Data from STL File Comparison 
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